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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).

iii



iv   Safety warning notice



Table of contents

1  Product description ........................................................................................................................................ 1

2  External component identification ................................................................................................................ 5
Top components ................................................................................................................................... 5

Pointing devices ................................................................................................................... 5
Lights ................................................................................................................................... 6
Buttons, switches, and fingerprint reader ............................................................................ 8
Keys ................................................................................................................................... 10
Display ............................................................................................................................... 11

Front components ..............................................................................................................................  12
Rear components ............................................................................................................................... 13
Right-side components ....................................................................................................................... 14
Left-side components ......................................................................................................................... 15
Bottom components ...........................................................................................................................  16
Wireless antennae (select models only) ............................................................................................. 18

3  Illustrated parts catalog ............................................................................................................................... 19
Serial number location ........................................................................................................................ 19
Computer major components ............................................................................................................. 21
Display components ........................................................................................................................... 27
Mass storage ...................................................................................................................................... 29
Plastics Kit .......................................................................................................................................... 31
Miscellaneous parts ............................................................................................................................ 32
Sequential part number listing ............................................................................................................ 33

4  Removal and replacement procedures ....................................................................................................... 37
Preliminary replacement requirements ............................................................................................... 37

Tools required .................................................................................................................... 37
Service considerations ....................................................................................................... 37

Plastic parts ....................................................................................................... 37
Cables and connectors .....................................................................................  38
Drive handling ................................................................................................... 38

Grounding guidelines ......................................................................................................... 39

v



Electrostatic discharge damage ........................................................................ 39
Packaging and transporting guidelines ............................................. 40
Workstation guidelines ..................................................................... 40
Equipment guidelines ....................................................................... 41

Unknown user password ................................................................................................... 42
Component replacement procedures ................................................................................................. 43

Service tag ......................................................................................................................... 44
Computer feet .................................................................................................................... 45
Battery ............................................................................................................................... 46
SIM .................................................................................................................................... 47
Bluetooth module ............................................................................................................... 48
Expansion memory module ............................................................................................... 50
WLAN module .................................................................................................................... 52
Primary hard drive ............................................................................................................. 55
WWAN module .................................................................................................................. 58
Optical drive ....................................................................................................................... 60
Switch cover and keyboard ................................................................................................ 62
RTC battery ....................................................................................................................... 66
Secondary hard drive ......................................................................................................... 67
Primary memory module .................................................................................................... 72
Display assembly ............................................................................................................... 73
Top cover ........................................................................................................................... 79
LED board .......................................................................................................................... 82
Speaker ............................................................................................................................. 84
Bluetooth module cable ..................................................................................................... 85
System board ..................................................................................................................... 86
ExpressCard assembly ...................................................................................................... 88
Modem module .................................................................................................................. 90
Fan ..................................................................................................................................... 92
Heat sink ............................................................................................................................ 94

5  Computer Setup ............................................................................................................................................ 96
Starting Computer Setup .................................................................................................................... 96
Using Computer Setup ....................................................................................................................... 97

Navigating and selecting in Computer Setup ..................................................................... 97
Restoring factory settings in Computer Setup ................................................................... 98

Computer Setup menus ..................................................................................................................... 99
File menu ........................................................................................................................... 99
Security menu .................................................................................................................. 100
Diagnostics menu ............................................................................................................ 101
System Configuration menu ............................................................................................ 102

vi



6  Specifications .............................................................................................................................................. 105
Computer specifications ................................................................................................................... 105
12.1-inch, WXGA display specifications ........................................................................................... 106
Hard drive specifications ..................................................................................................................  107
DVD-ROM Drive specifications ........................................................................................................  108
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive specifications ................................  109
System DMA specifications .............................................................................................................. 110
System interrupt specifications ......................................................................................................... 111
System I/O address specifications ...................................................................................................  112
System memory map specifications ................................................................................................. 114

7  Screw listing ................................................................................................................................................ 115
Phillips PM 2.0×4.0 screw ................................................................................................................  116
Torx T8M2.0×5.0 screw ...................................................................................................................  120
Torx T8M2.0×6.0 captive screw .......................................................................................................  123
Phillips PM2.5×4.0 screw .................................................................................................................  124
Phillips PM2.5×6.0 captive screw ..................................................................................................... 125
Phillips PM2.5×6.0 screw .................................................................................................................  126
Torx T8M2.5×6.0 screw ...................................................................................................................  128
Torx T8M2.5×9.0 captive screw .......................................................................................................  130
Phillips PM2.5×11.0 captive screw ................................................................................................... 131

8  Backup and recovery .................................................................................................................................. 132
Backup and recovery in Windows Vista ...........................................................................................  132

Overview .......................................................................................................................... 132
Backing up your information ............................................................................................  133
Performing a recovery .....................................................................................................  134

Using the Windows recovery tools ..................................................................  134
Using f11 .........................................................................................................  135
Using a Windows Vista operating system DVD (purchased separately) ......... 135

Backup and recovery in Windows XP ..............................................................................................  136
Overview .......................................................................................................................... 136
Backing up your information ............................................................................................  137
Performing a recovery .....................................................................................................  138

Recovering your information ...........................................................................  138
Recovering the operating system and programs ............................................  138

9  Connector pin assignments ....................................................................................................................... 139
Audio-in (microphone) ......................................................................................................................  139
Audio-out (headphone) ..................................................................................................................... 140
External monitor ...............................................................................................................................  141
IEEE 1394 (FireWire) .......................................................................................................................  142
RJ-11 (modem) ................................................................................................................................  143

vii



RJ-45 (network) ................................................................................................................................ 144
Universal Serial Bus ......................................................................................................................... 145

10  Power cord set requirements .................................................................................................................. 146
Requirements for all countries and regions ...................................................................................... 146
Requirements for specific countries and regions ............................................................................. 147

11  Recycling ................................................................................................................................................... 148
Battery .............................................................................................................................................. 148
Display .............................................................................................................................................. 149

Index ................................................................................................................................................................. 155

viii



1 Product description

Category Description

Product Name HP EliteBook 2530p Notebook PC

Processors Intel® LV Core™2 Duo, soldered uFBGA

● SL9600 2.13-GHz, 1066MHZ front side bus (FSB) with 6-MB cache

● SL9400 1.86-GHz, 1066MHz FSB with 6-MB cache

● SL9300 1.6-GHz, 1066MHz FSB with 6-MB cache

 Intel ULV Core2 Duo, soldered uFBGA

● SU9400, 1.4-GHz, 800 MHz, FSB with 3-MB cache

● SU9300, 1.2-GHz, 800MHz FSB with 3-MB cache

Chipset Mobile Intel Express GS45

 ICH9m-SFF-enhanced

Graphics Intel Universal Memory Architecture (UMA) graphics subsystem integrated with up to 384-MB
shared system memory

Panels 12.1-inch WXGA display assembly (1280 × 800) with Antiglare, includes 2 wireless local area
network (WLAN) antennae, and supports privacy filter

Memory Two customer-accessible/upgradable memory module slots

 Supports up to 8 GB of system RAM

 800-MHz, DDR2

 Supports the following configurations:

● 8192-MB total system memory (4096 × 2)

● 6144-MB total system memory (4096 + 2048)

● 5120-MB total system memory (4096 + 1024)

● 4096-MB total system memory (4096 × 1)

● 4096-MB total system memory (2048 × 2)

● 3072-MB total system memory (2048 + 1024)

● 2048-MB total system memory (2048 × 1)

● 2048-MB total system memory (1024 × 2)

● 1024-MB total system memory (1024 × 1)

1



Category Description

Hard drives Customer-accessible

 Supports the following SATA primary drives:

NOTE: The 4.57-cm (1.80-inch) primary hard drive must be installed in the hard drive bay.
Installation of this drive in the optical drive bay is not supported.

● 160-GB, 5400-rpm

● 120-GB, 5400-rpm

● 80-GB, 5400-rpm

 Supports the following primary solid-state drive:

● 80-GB, Intel

 Supports the following SATA secondary drives installed in the optical drive bay:

NOTE: The 6.35-cm (2.50-inch) secondary hard drive must be installed in the optical drive bay.
Installation of this drive in the hard drive bay is not supported. (This option is not available when
the optical drive is installed.)

● 320-GB, 7200-rpm

● 250-GB, 5400-rpm

● 160-GB, 7200-rpm

● 160-GB, 5400-rpm

● 120-GB, 5400-rpm

Optical drives Fixed (removal of 1 screw required)

NOTE: This option is not available with a secondary hard drive installed as primary storage.

 Customer-accessible

 Serial ATA (SATA)

 9.5-mm tray load

 Supports the following drive options:

● DVD-ROM Drive

● DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive

● No optical drive, with optical drive space-saver

Diskette drive Supports external USB diskette drive only

 Supports boot from external USB diskette drive

Audio HD audio - ADI1984A

 Integrated single speaker, no speaker branding

 Integrated dual-array microphone

Webcam Optional 2.1-megapixel webcam with support for a business card reader

Modem 56K V.92 data/fax modem

Ethernet Integrated Gigabit 10/100/1000 local access network (LAN)
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Category Description

 S4/S5 wake on LAN on AC power

 NIC power-down technology

Wireless LAN Integrated WLAN options by way of mini-slot which supports WLAN only:

 Support for 2 dual-band 2.4-/5.0-GHz WLAN antennae cabled to mini-slot

 Support for the following WLAN options:

● 802.11a/b/g with Intel Active Management Technology (iAMT) support

● 802.11a/b/g/n with iAMT support

● 802.11a/b/g/draft-n

● 802.11b/g

● no-WLAN option

 Integrated WWAN options by way of mini-slot which supports WWAN only:

 Support for 2 five-band WWAN antennae cabled to mini-slot

 SIM is user-accessible behind battery

 Supports the following WWAN options:

● HP un2400 Mobile Broadband Module

● WWAN aftermarket option

 Integrated WPAN option by way of mini-slot which supports WPAN only:

Supports no-wireless PAN option

Blueflame Bluetooth® module

External media card SD Card Reader supporting Secure Digital (SD) Memory Card and MultiMediaCard (MMC)

Ports Audio-in (stereo microphone)

 Audio-out (stereo headphone)

 Docking

 RJ-11 (modem)

 RJ-45 (Ethernet, includes link and activity lights)

 USB (2 ports on models with an optical drive installed, 3 ports on models without an optical drive
installed)

 VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75-GHz (hot plug/unplug with
auto-detect)

 3-pin AC power via the HP Smart AC Adapter

Docking HP 2400/2500 Series Docking Station

Keyboard/pointing
devices

Full–size 4.5-mm×19.05-mm keyboard with embedded numeric keypad

 Pointing stick with 2 pointing stick buttons

 TouchPad with 2 TouchPad buttons and vertical scrolling zone
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Category Description

 Spill-resistant keyboard

 Windows Vista® Start button

 Durable key caps

Power requirements 65-W Smart AC adapter with localized cable plug support (3-wire plug with ground pin)

 9-cell, 83.0-Wh Li-ion battery with fuel gauge

 6-cell, 55.0-Wh Li-ion battery with fuel gauge

 3-cell, 31.0-Wh Li-ion battery

Security Supports Kensington security lock

 Supports integrated USB-based fingerprint reader

Operating system Preinstalled:

 Vista Home Basic (32-bit)

 Vista Business (32-bit)

 Vista Ultimate (32-bit)

 FreeDOS

Serviceability End-user replaceable parts:

 AC adapter and power cord

 Battery (system)

 SIM

 Bluetooth module

 Memory module

 WLAN module

 WWAN module

 Optical drive

 RTC battery

 Switch cover

 Keyboard

 Primary hard drive

 Primary hard drive (solid-state)

 NOTE: The 4.57-cm (1.80-inch) primary hard drive must be installed in the hard drive bay.
Installation of this drive in the optical drive bay is not supported.

 Secondary hard drive

 NOTE: The 6.35-cm (2.50-inch) secondary hard drive must be installed in the optical drive bay.
Installation of this drive in the hard drive bay is not supported. (This option is not available when
the optical drive is installed.)
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2 External component identification

Top components
Pointing devices

Component Description

(1) Left TouchPad button* Functions like the left button on an external mouse.

(2) TouchPad* Moves the pointer and selects or activates items on the screen.

(3) Left pointing stick button* Functions like the left button on an external mouse.

(4) Pointing stick* Moves the pointer and selects or activates items on the screen.

(5) TouchPad on/off button Turns the TouchPad on and off.

(6) Right pointing stick button* Functions like the right button on an external mouse.

(7) TouchPad scroll zone Scrolls up or down.

(8) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

● For Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● For Windows® XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Lights

Component Description

(1) Power lights (2)* ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or Standby (Windows XP).

● Off: The computer is off or in Hibernation.

(2) Wireless lights (2)† ● Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device, the HP Mobile Broadband
Module, and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(3) TouchPad on/off light ● Turquoise: TouchPad is on.

● Amber: TouchPad is off.

(4) Caps lock light On: Caps lock is on.

(5) Num lock light On: Num lock is on or the embedded numeric keypad is enabled.

(6) Volume mute light ● Turquoise: Speaker sound is on.

● Amber: Speaker sound is off.
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Component Description

(7) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(8) Drive light ● Blinking turquoise: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.

*The 2 power lights display the same information. The light on the power button is visible only when the computer is open.
The power light on the front of the computer is visible whether the computer is open or closed.

†The 2 wireless lights display the same information. The light on the wireless button is visible only when the computer is
open. The wireless light on the front of the computer is visible whether the computer is open or closed.
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Buttons, switches, and fingerprint reader

Component Description

(1) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in the Sleep state (Windows Vista) or
Standby (Windows XP), press the button briefly to exit the
Sleep state or Standby.

● When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.

To learn more about your power settings:

● For Windows Vista, select Start > Control Panel > System
and Maintenance > Power Options.

● For Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(2) Info button Launches Info Center, which enables you to open various
software solutions.

(3) Internal display switch Turns off the display if the display is closed while the power is on.

(4) Wireless button Turns the wireless feature on or off but does not establish a
wireless connection.

NOTE: A wireless network must be set up in order to establish
a wireless connection.
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Component Description

(5) Presentation button Starts the presentation feature.

(6) TouchPad on/off button Turns the TouchPad on or off.

(7) Volume mute button Mutes and restores speaker sound.

(8) Volume scroll zone Adjusts speaker volume. Slide your finger to the left to decrease
volume and to the right to increase volume. You can also press
and hold the minus (–) sign to decrease volume, or press and
hold the plus (+) sign to increase volume.

(9) Fingerprint reader Allows a fingerprint logon to Windows, instead of a password
logon.

Top components 9



Keys

Component Description

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Display

Component Description

(1) Ambient light sensor Automatically adjusts the display brightness based on the lighting
conditions in your environment.

(2) Webcam light (select models only) On: The integrated camera is in use.

(3) Webcam (select models only) Records audio and video and captures still photographs.

(4) Keyboard light Illuminates the keyboard in low-light conditions when the
keyboard light button is pressed.

(5) Keyboard light button Opens and turns on the keyboard light.

(6) Internal microphone Records sound.

NOTE: The internal microphone makes use of dual array
technology, which provides speech enhancement and
suppresses surrounding noises.
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Front components

Component Description

(1) Wireless light ● Blue: An integrated wireless device, such as a wireless
local area network (WLAN) device, the HP Mobile
Broadband Module, and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or Standby (Windows XP).

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(4) Drive light ● Turquoise: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.

(5) Business card slot Holds a business card in position so that the webcam can
capture the information on the card.

(6) Display release button Opens the computer.
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Rear components

Component Description

(1) RJ-45 (network) jack Connects a network cable.

(2) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.
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Right-side components
NOTE: Refer to the illustration that most closely matches your computer.

Component Description

(1) ExpressCard slot Supports optional ExpressCards.

(2) SD Card Reader Supports the Secure Digital (SD) Memory Card and
MultiMediaCard (MMC) optional digital card formats.

(3) 1394 port Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.

(4) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

WARNING! To reduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset.
For additional safety information, refer to the Regulatory, Safety
and Environmental Notices.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(5) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(6) USB port Connects an optional USB device.

(7) External monitor port Connects an external VGA monitor or projector.

(8) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(9) Expansion port 3 Connects an optional docking device.
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Left-side components
NOTE: Refer to the illustration that most closely matches your computer.

Component Description

(1) Power connector Connects an AC adapter.

(2) RJ-11 (modem) jack Connects a modem cable.

(3) Powered USB port Provides power to an external device if used with a powered USB
cable.

(4) USB port Connects an optional USB device.

(5) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

Component Description

(1) Power connector Connects an AC adapter.

(2) RJ-11 (modem) jack Connects a modem cable.

(3) Powered USB port Provides power to an external device if used with a powered
USB cable.

(4) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for the
internal fan to cycle on and off during routine operation.

(5) Optical drive Reads and writes to an optical disc.
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Bottom components

Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.

(3) SIM slot (select models only) Contains a wireless subscriber identity module (SIM). The SIM
slot is located inside the battery bay.

(4) Broadband wireless module compartment Contains an HP Mobile Broadband Module (select models only).

CAUTION: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use in
the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and
then receive a warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

(5) Vents (5) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(6) Hard drive bay Holds the hard drive.

NOTE: The 4.57-cm (1.80-inch) primary hard drive must be
installed in the hard drive bay. Installation of this drive in the
optical drive bay is not supported.

(7) Bluetooth compartment Contains a Bluetooth device.
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Component Description

(8) Speaker Produces sound.

(9) Memory module compartment Contains an expansion memory module slot and a WLAN module
(select models only).

NOTE: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use in
the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and
then receive a warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.
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Wireless antennae (select models only)

Component Description

(1) WLAN antennae (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(2) WWAN antennae (2)* Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

*The antennae are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennae free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.
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3 Illustrated parts catalog

Serial number location
The service tag, affixed to the bottom of the computer, provides information that may be needed
when troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components
and parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: This number describes the duration of the warranty period for the computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer major components

Item Description Spare part number

(1) 12.1-inch, WXGA AntiGlare display assembly (See Display components on page 27 for display assembly
component spare part number information.)
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Item Description Spare part number

 With webcam 492576-001

 Without webcam 492575-001

(2) Switch cover (includes display lid switch board and cable and LED board and cable) 492556-001

(3) Keyboard with pointing stick (includes keyboard cable and pointing stick cable)

 ● For use in Brazil 506677-201

 ● For use in the Czech Republic 506677-221

 ● For use in Denmark 506677-081

 ● For use in Europe 506677-021

 ● For use in Finland and Sweden 506677-B71

 ● For use in France 506677-051

 ● For use in French Canada 506677-121

 ● For use in Germany 506677-041

 ● For use in Greece 506677-151

 ● For use in Hungary 506677-211

 ● For use in Iceland 506677-DD1

 ● For use in Israel 506677-BB1

 ● For use in Italy 506677-061

 ● For use in Japan 506677-291

 ● For use in Latin America 506677-161

 ● For use in the Netherlands and Europe 506677-A41

 ● For use in Norway 506677-091

 ● For use in Portugal 506677-131

 ● For use in Russia 506677-251

 ● For use in Saudi Arabia 506677-171

 ● For use in Slovakia 506677-231

 ● For use in South Korea 506677-AD1

 ● For use in Spain 506677-071

 ● For use in Switzerland 506677-111

 ● For use in Taiwan 506677-AB1

 ● For use in Thailand 506677-281

 ● For use in Turkey 506677-141

 ● For use in the United Kingdom 506677-031

 ● For use in the United States 506677-001

(4) RTC battery 481089-001
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Item Description Spare part number

(5) Memory modules (2, PC2-6400, 800-MHz, DDR2)

 4-GB 492572-001

 2-GB 492571-001

 1-GB 492570-001

(6) Top cover (includes TouchPad board and cable, TouchPad button board and cable, and
TouchPad bracket)

 

 With fingerprint reader 492557-001

 Without fingerprint reader 514059-001

(7) Speaker 481109-001

(8) ExpressCard assembly 492567-001

 Plastics Kit (See Plastics Kit on page 31 for more Plastics Kit spare part information): 492577-001

(9a) ExpressCard slot bezel

(9b) Bluetooth module compartment cover

(9c) Wireless module compartment cover

(9d) Memory module compartment cover

(9e) Hard drive cover

NOTE: The 4.57-cm (1.80-inch) primary hard drive must be installed in the hard drive bay. Installation of this drive
in the optical drive bay is not supported.

(10) LED board (includes cable and Mylar cover) 499209-001

(11) System board (includes processor, replacement thermal material, and replacement
thermal material cleaning kit)

 

 With LV SL9600 processor 513947-001

 With LV SL9400 processor 492552-001

 With LV SL9300 processor 492551-001

 With ULV SU9400 processor 513946-001

 With ULV SU9300 processor 492553-001

(12) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The modem module cable is
included in the Cable Kit, spare part number 492555-001.

 For use in all countries and regions except Australia and New Zealand 461750-001

 For use only in Australia and New Zealand 461750-011

(13) Fan 492568-001

(14) Heat sink (includes replacement thermal material and replacement thermal material
cleaning kit)

492582–001

(15) Optical drive (includes bezel and bracket)

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive 492559-001
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Item Description Spare part number

 DVD-ROM Drive 492558-001

(16) Base enclosure (includes display latch switch, battery release latch, and rubber feet) 492547-001

(17) Hard drives (2, include bezel and bracket)

 Primary hard drive

NOTE: The 4.57-cm (1.80-inch) primary hard drive must be installed in the hard drive bay. Installation of this drive
in the optical drive bay is not supported.

 ● 160-GB, 5400-rpm hard drive 503732-001

 ● 120-GB, 5400-rpm hard drive 492560-001

 ● 80-GB, 5400-rpm hard drive 492565-001

 ● 80-GB, solid-state hard drive 492566-001

 Secondary hard drive

NOTE: The 6.35-cm (2.50-inch) secondary hard drive must be installed in the optical drive bay. Installation of this
drive in the hard drive bay is not supported. (This option is not available when the optical drive is installed.)

 ● 320-GB, 7200-rpm hard drive 513949-001

 ● 250-GB, 5400-rpm hard drive 513948-001

 ● 160-GB, 7200-rpm hard drive 492564-001

 ● 160-GB, 5400-rpm hard drive 513950-001

 ● 120-GB, 5400-prm hard drive 492561-001

(18) Secondary hard drive cage assembly (includes additional USB port; required for
installation of secondary hard drive)

492574-001

 Secondary hard drive connector board (required for installation of secondary hard drive) 495027-001

 Secondary hard drive system connector board (required for installation of secondary hard
drive)

495028-001

(19) Bluetooth module 483113-001

(20) Bluetooth module cable (included in the Cable Kit, spare part number 492555-001)

(21) Battery

 9-cell, 83.0-WH Li-ion 492550-001

 6-cell, 55.0-WH Li-ion 492549-001

 3-cell, 31.0-WH Li-ion 492548-001

(22) WLAN module

 802.11a/b/g/n WLAN modules:

 ● Intel WiFi Link 5100ABGN for use in Antigua and Barbuda, Argentina, Aruba,
the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile,
Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam,
Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

480985-001
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Item Description Spare part number

 ● Broadcom 4322AGN WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia,
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

 ● Broadcom 4322AGN WiFi Adapter for use in the United States and Canada 487330-001

 ● Intel WiFi Link 5100ABGN with Active Management Technology (AMT) for use in
the United States and Canada

506678-001

 802.11a/b/g WLAN modules:

 ● Intel WiFi Link 5100ABG for use in the United States and Canada 482957-001

 ● Intel WiFi Link 5100ABG with AMT for use in the United States and Canada 506680-001

 802.11b/g WLAN modules:
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Item Description Spare part number

 ● Broadcom 4312G WiFi Adapter for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil,
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles,
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau,
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia,
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

 ● Broadcom 4312G WiFi Adapter for use in the United States and Canada 459263-001

(23) HP un2400 Mobile Broadband Module 483377-002
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Display components

Item Description Spare part number

(1) Display bezel (includes HP logo and computer model number label)  

 For use with models that include a webcam 495022-001

 For use with models that do not include a webcam 495019-001

 Display bezel adhesive (not illustrated) 497013-001

(2) Display Hinge Kit (includes left and right hinges and brackets) 481098-001

(3) Display panel cable  

 For use with models that include a webcam 495023-001

 For use with models that do not include a webcam 495021-001

(4) Microphone 492573-001

(5) Display enclosure (includes HP logo, wireless antenna transceivers, and cables)  
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Item Description Spare part number

 With webcam 496490-001

 Without webcam 495020-001

28 Chapter 3   Illustrated parts catalog



Mass storage

Item Description Spare part number

(1) Primary hard drive

NOTE: The 4.57-cm (1.80-inch) primary hard drive must be installed in the hard drive bay. Installation of this drive
in the optical drive bay is not supported.

 160-GB, 5400-rpm hard drive 503732-001

 120-GB, 5400-rpm hard drive 492560-001

 80-GB, 5400-rpm hard drive 492565-001

 80-GB, solid-state hard drive 492566-001

 Primary hard drive connector board (required for installation of primary hard drive) 495026-001

(2) Secondary hard drive

NOTE: The 6.35-cm (2.50-inch) secondary hard drive must be installed in the optical drive bay. Installation of this
drive in the hard drive bay is not supported. (This option is not available when the optical drive is installed.)

 320-GB, 7200-rpm hard drive 513949-001

 250-GB, 5400-rpm hard drive 513948-001

 160-GB, 7200-rpm hard drive 492564-001

 160-GB, 5400-rpm hard drive 513950-001

 120-GB, 5400-prm hard drive 492561-001

 Secondary hard drive cage assembly, includes additional USB port (required for
installation of secondary hard drive

492574-001

 Secondary hard drive connector board (required for installation of secondary hard drive) 495027-001
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Item Description Spare part number

 Secondary hard drive system connector board (required for installation of secondary hard
drive)

495028-001

(3) Optical drive

 DVD-ROM Drive 492558-001

 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive 492559-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 492577-001

(1) ExpressCard slot insert

(2) Bluetooth module compartment cover (includes one captive screw, secured by a C-clip)

(3) Broadband wireless module compartment cover (includes one captive screw, secured by
a C-clip)

 

(4) Hard drive bay cover (includes 2 captive screws, secured by C-clips)

NOTE: The 4.57-cm (1.80-inch) primary hard drive must be installed in the hard drive bay. Installation of this drive
in the optical drive bay is not supported.

(5) Memory module compartment cover, (includes one captive screw, secured by a C-clip)
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Miscellaneous parts
Description Spare part number

65-W Smart AC Adapter 463958-001

Cable Kit, includes Bluetooth, LED, and modem cables 492555-001

Optical drive bay insert assembly, includes additional USB port 498455-001

Power cord 490371-001

Rubber Kit (includes all rubber/mylar computer components) 492578-001

Screw Kit 492579-001

Smart card reader 492581-001
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Sequential part number listing
Spare part
number

Description

459263-001 Broadcom 4312G WiFi Adapter (802.11b/g WLAN module) for use in the United States and Canada

459263-002 Broadcom 4312G WiFi Adapter (802.11b/g WLAN module) for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

461750-001 Modem module for use in all countries and regions except Australia and New Zealand

461750-011 Modem module for use only in Australia and New Zealand

463958-001 65-W Smart AC Adapter

480985-001 Intel WiFi Link 5100ABGN (802.11a/b/g/n WLAN module) for use in Antigua and Barbuda, Argentina,
Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia,
Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras,
Hong Kong, India, Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

481089-001 RTC battery

481098-001 Display Hinge Kit (includes left and right hinges and brackets)

481109-001 Speaker

482957-001 Intel WiFi Link 5100ABG (802.11a/b/g WLAN module) for use in the United States and Canada

483113-001 Bluetooth module

483377-002 HP un2400 Mobile Broadband Module

487330-001 Broadcom 4322AGN WiFi Adapter (802.11a/b/g/n WLAN module) for use in the United States and Canada
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Spare part
number

Description

487330-002 Broadcom 4322AGN WiFi Adapter (802.11a/b/g/n WLAN module) for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China,
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka,
St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

490371-001 Power cord

492547-001 Base enclosure (includes display latch switch, battery release latch, and rubber feet)

492548-001 3-cell, 31.0-Wh Li-ion battery

492549-001 6-cell, 55.0-Wh Li-ion battery

492550-001 9-cell, 83.0-Wh Li-ion battery

492551-001 System board with LV SL9300 processor (includes processor, replacement thermal material, and
replacement thermal material cleaning kit)

492552-001 System board with LV SL9400 processor (includes processor, replacement thermal material, and
replacement thermal material cleaning kit)

492553-001 System board with ULV SU9300 processor (includes processor, replacement thermal material, and
replacement thermal material cleaning kit)

492555-001 Cable Kit (includes Bluetooth, LED, and modem cables)

492556-001 Switch cover (includes display lid switch board and cable)

492557-001 Top cover (includes TouchPad board and cable, TouchPad button board and cable, TouchPad bracket, and
fingerprint reader board)

492558-001 DVD-ROM Drive

492559-001 DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive

492560-001 120-GB, 5400-rpm, 4.57-cm (1.80-inch) primary hard drive

492561-001 120-GB, 5400-prm, 6.35-cm (2.50-inch) secondary hard drive

492564-001 160-GB, 7200-rpm, 6.35-cm (2.50-inch) secondary hard drive

492565-001 80-GB, 5400-rpm, 4.57-cm (1.80-inch) primary hard drive

492566-001 80-GB, solid-state, 4.57-cm (1.80-inch) primary hard drive

492567-001 ExpressCard assembly
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Spare part
number

Description

492568-001 Fan

492570-001 1-GB, PC2-6400, 800-MHz, DDR2 memory module

492571-001 2-GB, PC2-6400, 800-MHz, DDR2 memory module

492572-001 4-GB, PC2-6400, 800-MHz, DDR2 memory module

492573-001 Microphone

492574-001 6.35-cm (2.50-inch) secondary hard drive cage assembly (includes additional USB port)

492575-001 12.1-inch, WXGA AntiGlare display assembly (without webcam)

492576-001 12.1-inch, WXGA AntiGlare display assembly (with webcam)

492577-001 Plastics Kit

492578-001 Rubber Kit (includes all rubber/mylar computer components)

492579-001 Screw Kit

492581-001 Smart card reader

492582–001 Heat sink (includes replacement thermal material and replacement thermal material cleaning kit)

495019-001 Display bezel for use with models that do not include a webcam (include HP logo and computer model
number label)

495020-001 Display enclosure without webcam (includes HP logo, wireless antenna transceivers and cables)

495021-001 Display panel cable for use with models that do not include a webcam

495022-001 Display bezel for use with models that do not include a webcam (include HP logo and computer model
number label)

495023-001 Display panel cable for use with models that include a webcam

495026-001 4.57-cm (1.80-inch) primary hard drive connector board

495027-001 6.35-cm (2.50-inch) secondary hard drive connector board

495028-001 6.35-cm (2.50-inch) secondary hard drive system connector board

496490-001 Display enclosure with webcam (includes HP logo, wireless antenna transceivers and cables)

497013-001 Display bezel adhesive 

498455-001 Optical drive bay insert assembly, includes additional USB port

499209-001 LED board (includes cable and Mylar cover)

503732-001 160-GB, 5400-rpm, 4.57-cm (1.80-inch ) primary hard drive

506677-001 Keyboard with pointing stick for use in the United States

506677-021 Keyboard with pointing stick for use in Europe

506677-031 Keyboard with pointing stick for use in the United Kingdom

506677-041 Keyboard with pointing stick for use in Germany

506677-051 Keyboard with pointing stick for use in France

506677-061 Keyboard with pointing stick for use in Italy
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Spare part
number

Description

506677-071 Keyboard with pointing stick for use in Spain

506677-081 Keyboard with pointing stick for use in Denmark

506677-091 Keyboard with pointing stick for use in Norway

506677-111 Keyboard with pointing stick for use in Switzerland

506677-121 Keyboard with pointing stick for use in French Canada

506677-131 Keyboard with pointing stick for use in Portugal

506677-141 Keyboard with pointing stick for use in Turkey

506677-151 Keyboard with pointing stick for use in Greece

506677-161 Keyboard with pointing stick for use in Latin America

506677-171 Keyboard with pointing stick for use in Saudi Arabia

506677-201 Keyboard with pointing stick for use in Brazil

506677-211 Keyboard with pointing stick for use in Hungary

506677-221 Keyboard with pointing stick for use in the Czech Republic

506677-231 Keyboard with pointing stick for use in Slovakia

506677-251 Keyboard with pointing stick for use in Russia

506677-281 Keyboard with pointing stick for use in Thailand

506677-291 Keyboard with pointing stick for use in Japan

506677-A41 Keyboard with pointing stick for use in the Netherlands and Europe

506677-AB1 Keyboard with pointing stick for use in Taiwan

506677-AD1 Keyboard with pointing stick for use in South Korea

506677-B71 Keyboard with pointing stick for use in Finland and Sweden

506677-BB1 Keyboard with pointing stick for use in Israel

506677-DD1 Keyboard with pointing stick for use in Iceland

506678-001 Intel WiFi Link 5100ABGN with AMT (802.11a/b/g/n WLAN module) for use in the United States and
Canada

506680-001 Intel WiFi Link 5100ABG with AMT (802.11a/b/g WLAN module) for use in the United States and Canada

513946-001 System board with ULV SU9400 processor (includes processor, replacement thermal material, and
replacement thermal material cleaning kit)

513947-001 System board with LV SL9600 processor (includes processor, replacement thermal material, and
replacement thermal material cleaning kit)

513948-001 250-GB, 5400-rpm, 6.35-cm (2.50-inch) secondary hard drive

513949-001 320-GB, 7200-rpm, 6.35-cm (2.50-inch) secondary hard drive

513950-001 160-GB, 5400-rpm, 6.35-cm (2.50-inch) secondary hard drive

514059-001 Top cover (includes TouchPad board and cable, TouchPad button board and cable, and TouchPad bracket)
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting an internal hard drive, shut down the computer. If you are unsure
whether the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing an internal hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors or
speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.

40 Chapter 4   Removal and replacement procedures



Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 66).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 60 screws, in 9 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.
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Service tag
The service tag, affixed to the bottom of the computer, provides information that may be needed
when troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.

(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components
and parts are needed.

(4) Model description: This is the number used to locate documents, drivers, and support for the
computer.

(5) Warranty period: This number describes the duration of the warranty period for the computer.

44 Chapter 4   Removal and replacement procedures



Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 492578-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

9-cell, 83.0-Wh Li-ion battery 492550-001

6-cell, 55.0-Wh Li-ion battery 492549-001

3-cell, 31.0-Wh Li-ion battery 492548-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to insert the SIM.
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Bluetooth module

Description Spare part number

Bluetooth module 483113-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the Bluetooth module:

1. Loosen the Phillips PM2.5×6.0 captive screw (1) that secures the Bluetooth module cover to the
computer. (The edge of the module opposite the slot rises away from the computer.)

2. Lift the front edge of the cover (2), swing it back, and remove the cover. The Bluetooth module
compartment cover is included in the Plastics Kit, spare part number 492577-001.

3. Disconnect the Bluetooth module cable from the Bluetooth module (1).

4. Remove the Phillips PM2.0×4.0 screw (2) that secures the Bluetooth module to the Bluetooth
module compartment cover.
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5. Remove the Bluetooth module (3).

Reverse the above procedure to install the Bluetooth module.
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Expansion memory module

Description Spare part number

Memory modules (PC2-6400, 800-MHz, DDR2)  

4-GB 492572-001

2-GB 492571-001

1-GB 492570-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the memory module:

1. Loosen the Phillips PM2.5×6.0 captive screw (1) that secures the memory module compartment
cover to the computer.

2. Lift the front edge of the cover (2), swing it back, and remove the cover (3). The memory module
compartment cover is included in the Plastics Kit, spare part number 492577-001.

3. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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4. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: The memory module is designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the memory module.
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WLAN module

Description Spare part number

● Intel WiFi Link 5100ABGN (802.11a/b/g/n WLAN module): For use in Antigua & Barbuda,
Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei, Canada, the Cayman Islands,
Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El Salvador, Guam,
Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico, Panama,
Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

480985-001

● Broadcom 4322AGN WiFi Adapter (802.11a/b/g/n WLAN module): For use in Afghanistan,
Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina, Armenia, Aruba, Australia,
Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana, Brazil, the British Virgin
Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

● Broadcom 4322AGN WiFi Adapter (802.11a/b/g/n WLAN module): For use in the United
States and Canada

487330-001

● Intel WiFi Link 5100ABGN with AMT (active management technology) (802.11a/b/g/n WLAN
module): For use in the United States and Canada

506678-001

● Intel WiFi Link 5100ABG (802.11a/b/g WLAN module): For use in the United States and
Canada

482957-001

● Intel WiFi Link 5100ABG with AMT (active management technology) (802.11a/b/g WLAN
module): For use in the United States and Canada

506680-001
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Description Spare part number

● Broadcom 4312G WiFi Adapter (802.11b/g WLAN module): For use in Afghanistan, Albania,
Algeria, Andorra, Angola, Antigua & Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin,
Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina Botswana, Brazil, the British Virgin Islands,
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru,
the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

● Broadcom 4312G WiFi Adapter (802.11b/g WLAN module): For use in the United States and
Canada

459263-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the WLAN module:

1. Loosen the Phillips PM2.5×6.0 captive screw (1) that secures the memory module compartment
cover to the computer.
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2. Lift the front edge of the memory module compartment cover (2), swing it back, and remove the
cover (3). The memory module compartment cover is included in the Plastics Kit, spare part
number 492577-001.

3. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

4. Remove the two Phillips PM2.0×4.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

5. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Primary hard drive
NOTE: The 4.57-cm (1.80-inch) primary hard drive must be installed in the hard drive bay.
Installation of this drive in the optical drive bay is not supported.

NOTE: All primary hard drive spare part kits include a hard drive bracket.

Description Spare part number

160-GB, 5400-rpm hard drive 503732-001

120-GB, 5400-rpm hard drive 492560-001

80-GB, 5400-rpm hard drive 492565-001

80-GB, solid-state hard drive 492566-001

Primary hard drive connector board (required for installation of primary hard drive) 495026-001

Before removing the primary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the primary hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.5×6.0 captive screws (1) that secure the primary hard drive bay
cover to the computer.

3. Lift the inner side of the primary hard drive bay cover (2), swing it up, and remove the cover (3).
The primary hard drive bay cover is included in the Plastics Kit, spare part number 492577-001.
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4. Loosen the 2 Phillips 2.0×6.0 captive screws (1) that secure the hard drive bracket, and remove
the hard drive bracket (2).

5. Remove the Phillips screw that secures the connector board to the base enclosure(3).

6. Tilt the primary hard drive up toward you (1) to disengage it from the compartment.

7. Grasp the edges of the connector board, and disconnect the hard drive (2) from the connector
board.

8. Remove the hard drive (3).
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9. Pull the edges of the protective rubber gasket out and away from the hard drive (1), and remove
the gasket (2).

10. If it is necessary to replace the primary hard drive connector board, release the ZIF connectors
(1) to which the primary hard drive connector board cable is attached, and disconnect the cable
(2).

11. Remove the primary hard drive connector board (3).

Reverse this procedure to reassemble and install the primary hard drive.
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WWAN module

Description Spare part number

HP un2400 Mobile Broadband Module 483377-002

CAUTION: The WWAN module and the WLAN module are not interchangeable.

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

Remove the WWAN module:

1. Loosen the Phillips PM2.5×6.0 captive screw (1) that secures the broadband wireless module
cover to the computer. (The edge of the module opposite the slot rises away from the computer.)

2. Lift the inside edge of the cover and slide out to disengage the tabs (2).

3. Remove the cover (3).

4. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.
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5. Remove the two Phillips PM2.0×4.0 screws that secure the module to the computer (2).

6. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Optical drive

Description Spare part number

Optical drives

DVD-ROM Drive 492558-001

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive 492559-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the memory module compartment cover (see Expansion memory module on page 50).

Remove the optical drive:

1. Position the computer with the right side toward you.

2. Remove the Mylar screw cover (1) that secures the optical drive retention screw. The Mylar
screw cover is available in the Rubber Kit, spare part number 481106-001.

3. Remove the two Torx T8M2.0×5.0 screws (2) that secure the optical drive to the computer.

4. Remove the optical drive (3) from the computer.

5. If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

6. Remove the two Phillips PM2.0×4.0 screws (1) that secure the optical drive bracket to the optical
drive.
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7. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install an optical drive.
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Switch cover and keyboard

Description Spare part number

Switch cover (includes display lid switch board and cable) 492556-001

Keyboard with pointing stick (includes keyboard cable and pointing stick cable)

● For use in Brazil 506677-201

● For use in the Czech Republic 506677-221

● For use in Denmark 506677-081

● For use in Europe 506677-021

● For use in Finland and Sweden 506677-B71

● For use in France 506677-051

● For use in French Canada 506677-121

● For use in Germany 506677-041

● For use in Greece 506677-151

● For use in Hungary 506677-211

● For use in Iceland 506677-DD1

● For use in Israel 506677-BB1

● For use in Italy 506677-061

● For use in Japan 506677-291

● For use in Latin America 506677-161

● For use in the Netherlands and Europe 506677-A41

● For use in Norway 506677-091

● For use in Portugal 506677-131

● For use in Russia 506677-251

● For use in Saudi Arabia 506677-171

● For use in Slovakia 506677-231

● For use in South Korea 506677-AD1

● For use in Spain 506677-071

● For use in Switzerland 506677-111

● For use in Taiwan 506677-AB1

● For use in Thailand 506677-281

● For use in Turkey 506677-141

● For use in the United Kingdom 506677-031

● For use in the United States 506677-001
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Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the WWAN module compartment cover (see WWAN module on page 58).

6. Remove the expansion memory module compartment cover (see Expansion memory module
on page 50).

7. Remove the hard drive bay cover (see Primary hard drive on page 55).

Remove the switch cover and keyboard:

1. Position the computer with the rear panel toward you.

2. Remove the Phillips PM2.5×6.0 screw (1) that secures the switch cover to the computer.

3. Loosen the five Phillips PM2.5×11.0 captive screws (2) that secure the keyboard to the
computer.

4. Turn the computer right-side up, with the front toward you.

5. Open the display as far as possible.
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6. Release the switch cover (1) by sliding it to the right, and then lifting it (2) as far as the LED
board cable and the power button board cable allow.

7. Lift the rear edge of the keyboard and swing it up and forward until it rests upside down on the
palm rest.

8. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.
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9. Release the ZIF connector (3) to which the pointing stick cable is attached, and disconnect the
pointing stick cable (4) from the system board.

10. Remove the keyboard.

11. Disconnect the LED board cable (1) and the power button board cable (2) from the system
board.

12. Remove the switch cover.

Reverse this procedure to install the switch cover and keyboard.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery 481089-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Release the switch cover and keyboard (see Switch cover and keyboard on page 62).

6. Use a fingernail or other tool to lift the RTC battery from the socket (1).

7. Remove the RTC battery from the socket on the system board (2).

Reverse this procedure to install the RTC battery.
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Secondary hard drive
NOTE: The 6.35-cm (2.50-inch) secondary hard drive must be installed in the optical drive bay.
Installation of this drive in the hard drive bay is not supported. (This option is not available when the
optical drive is installed.)

Description Spare part number

320-GB, 7200-rpm hard drive 513949-001

250-GB, 5400-rpm hard drive 513948-001

160-GB, 7200-rpm hard drive 492564-001

160-GB, 5400-rpm hard drive 513950-001

120-GB, 5400-rpm hard drive 492561-001

Secondary hard drive cage assembly, includes additional USB port (required for
installation of secondary hard drive

492574-001

Secondary hard drive connector board (required for installation of secondary hard drive) 495027-001

Secondary hard drive system connector board (required for installation of secondary hard
drive)

495028-001

NOTE: The optional secondary hard drive is installed in the optical drive bay, and replaces the
optical drive.

Before removing the secondary hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery. (See Battery on page 46)

5. Remove the switch cover and keyboard. (See Switch cover and keyboard on page 62)

Remove the secondary hard drive:

1. Close the display, and position the computer upside down, with the right side toward you.
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2. Remove the 5 Mylar screw covers (1), the 4 Phillips screws (2), and the 2 Phillips PM2.0×6.0
screws (3) that secure the secondary hard drive cradle assembly to the computer.

3. Turn the computer right-side up, and open the display as far as possible.

4. Disconnect the secondary hard drive cradle assembly USB cable from the system board.

5. Release the USB cable from all obstructions (1) and tuck the excess cable and connector
securely into the cradle assembly (2).

NOTE: Be sure that the USB connector and cable are completely disconnected from the
system board and secured inside the cradle assembly before you remove the cradle assembly
from the optical drive bay.
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6. Remove the secondary hard drive cradle assembly (3) from the optical drive bay.

7. Remove the four Phillips PM3.0×4.0 secondary hard drive screws that secure the secondary
hard drive to the cradle assembly.

8. Tilt the hard drive up and away from the connector board (1), and disconnect the hard drive from
the connector board (2).
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9. Remove the hard drive from the cradle assembly (3).

10. If it is necessary to replace the secondary hard drive connector board, remove the two Phillips
screws that secure the connector board to the cradle assembly (1).

11. Remove the secondary hard drive connector board (2).

12. If it is necessary to replace the secondary hard drive system connector board, remove the two
Phillips screws that secure the connector board to the cradle assembly (1).

13. Release the ZIF connector (2), and disconnect the cable (3).
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14. Remove the secondary hard drive system connector board (4).

Reverse the above procedure to reassemble and install the secondary hard drive.
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Primary memory module

Description Spare part number

Memory modules (PC2-6400, 800-MHz, DDR2)  

4-GB 492572-001

2-GB 492571-001

1-GB 492570-001

Before removing the primary memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Release the switch cover and keyboard (see Switch cover and keyboard on page 62).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: The memory module is designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install the memory module.
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Display assembly

Description Spare part number

12.1-inch, WXGA AntiGlare display assembly  

With a webcam 492576-001

Without a webcam 492575-001

Display bezel (includes HP logo and computer model number label)  

For use with models that include a webcam 495022-001

For use with models that do not include a webcam 495019-001

Display bezel adhesive 497013-001

Display Hinge Kit (includes left and right hinges and brackets) 481098-001

Display panel cable  

For use with models that include a webcam 495023-001

For use with models that do not include a webcam 495021-001

Microphone 492573-001

Display enclosure (includes HP logo, wireless antenna transceivers and cables)  

With webcam 496490-001

Without webcam 495020-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the Bluetooth compartment cover (see Bluetooth module on page 48).

6. Remove the memory module compartment cover (see Expansion memory module on page 50).

7. Remove the hard drive bay cover (see Primary hard drive on page 55).

8. Remove the broadband wireless compartment cover (see WWAN module on page 58).

9. Remove the switch cover and keyboard (see Switch cover and keyboard on page 62).

Remove the display assembly:

1. Close the computer and turn it upside down, with the rear panel toward you.

2. Disconnect the wireless antenna cables from the WLAN module (1), and feed them down
through the hole (2).
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3. Disconnect the wireless antenna cables from the WWAN module (3), and feed them down
through the hole (4).

4. Turn the computer right side up, and open the display .

5. Thread the WLAN (1) and WWAN (2) cables out through the top cover, and release the cables
from the top cover clips (3).

6. Close the computer and turn the computer upside down, with the rear of the computer toward
you.
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7. Remove the two Mylar screw covers (1) and the four Torx T8M2.0×6.0 screws (2) that secure
the display assembly to the computer.

8. Turn the computer right-side up, with the front toward you.

9. Open the computer.

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.

10. Remove the two Torx8 T8M2.5×6.0 screws (one at each hinge) (1) that secure the display
assembly hinges to the computer.

11. Lift the display assembly straight up to remove it (2).
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12. If it is necessary to replace the display bezel, remove the four rubber screw covers (1) and the
four Torx T8M2.5×6.0 screws (2) that secure the display bezel to the display assembly.

NOTE: The rubber screw covers on the display bezel top edge are thicker than the rubber
screw covers on the display bezel bottom edge.

13. Flex the inside edges of the bottom (1), left and right sides (2), and the top (3) of the display
bezel until the bezel disengages from the display enclosure.

14. Remove the display bezel (4).

NOTE: Remove excess adhesive from the bezel and display enclosure when you remove the
bezel, and reapply adhesive before replacing the bezel.

15. If it is necessary to replace the display hinges, remove the two Phillips PM2.5×4.0 screws (1)
that secure the display panel to the display enclosure.

16. Disconnect the display passthrough board and camera passthrough board cables (2).
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17. Remove the display panel (3).

18. Remove the two Phillips PM2.0×4.0 screws (1) that secure each display hinge to the display
panel.

19. Remove the display hinges (2).

20. If it is necessary to replace the display panel cable, turn the display panel upside down, with the
display panel bottom edge toward you.

21. Disconnect the display panel cable from the inverter (1).

22. Disconnect the display panel cable (2) from the display panel.
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23. Remove the display panel cable (3).

24. If it is necessary to replace the microphones (1), remove the microphones from the display
enclosure (2).

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover (includes TouchPad board and cable, TouchPad button board and cable, and
TouchPad bracket)

 

With fingerprint reader 492557-001

Without fingerprint reader 514059-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

c. Switch cover and keyboard (see Switch cover and keyboard on page 62)

d. Display assembly (see Display assembly on page 73)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the following screw covers and screws:

(1) Four rubber screw covers. The rubber screw covers are included in the Rubber Kit, spare
part number 481106-001.

(2) Six Torx T8M2.5×6.0 screws.

(3) One Phillips PM2.0×5.0 screw.

(4) One Torx T8M2.0×5.0 screw.

3. Turn the computer right-side up, with the front toward you.

4. Disconnect the TouchPad cable (1), and the fingerprint reader board cable (2) from the system
board.

5. Remove the two Torx T8M2.5×6.0 screws (3) and the Phillips PM2.0×6.0 screw (4) that secure
the top cover to the computer.
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6. Lift the rear edge of the top cover (1) and swing it up and forward until it rests at an angle.

7. Lift the front edge of the top cover (2) until it disengages from the base enclosure.

8. Remove the top cover.

Reverse this procedure to install the top cover.
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LED board

Description Spare part number

LED board (includes cable and Mylar cover) 499209-001

Before removing the LED board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. Optical drive (see Optical drive on page 60) or secondary hard drive (see Secondary hard
drive on page 67)

c. Switch cover and keyboard (see Switch cover and keyboard on page 62)

d. Display assembly (see Display assembly on page 73)

e. Top cover (see Top cover on page 79)

Remove the LED board:

1. Release the ZIF connector to which the LED board cable is connected and disconnect the LED
board cable (1) from the system board.

2. Release the LED board cable (2) from the base enclosure. The LED board cable is attached to
the base enclosure with double-sided tape.
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3. Release the LED board (3) from the clips built into the base enclosure.

4. Remove the LED board and cable.

Reverse the above procedure to install the LED board.
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Speaker

Description Spare part number

Speaker 481109-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

c. Switch cover and keyboard (see Switch cover and keyboard on page 62)

d. Display assembly (see Display assembly on page 73)

e. Top cover (see Top cover on page 79)

Remove the speaker:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the Phillips PM2.0×4.0 screw (2) that secures the speaker to the base enclosure.

3. Remove the speaker (3) from the base enclosure.

Reverse this procedure to install the speaker.

84 Chapter 4   Removal and replacement procedures



Bluetooth module cable
NOTE: The Bluetooth module cable is included in the Cable Kit, spare part number 492555-001.

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. WLAN module (see WLAN module on page 52)

c. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

d. Switch cover and keyboard (see Switch cover and keyboard on page 62)

e. Display assembly (see Display assembly on page 73)

f. Top cover (see Top cover on page 79)

Remove the Bluetooth module cable:

1. Release the Bluetooth module cable (1) from the opening in the base enclosure.

2. Disconnect the Bluetooth module cable (2) from the system board.

3. Remove the Bluetooth module cable.

Reverse this procedure to install the Bluetooth module cable.
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System board

Description Spare part number

System board (includes processor, replacement thermal material, and replacement thermal
material cleaning kit)

 

With LV SL9600 processor 513947-001

With LV SL9400 processor 492552-001

With LV SL9300 processor 492551-001

With ULV SU9400 processor 513946-001

With ULV SU9300 processor 492553-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. WLAN module (see WLAN module on page 52)

c. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

d. Switch cover and keyboard (see Switch cover and keyboard on page 62)

e. Display assembly (see Display assembly on page 73)

f. Top cover (see Top cover on page 79)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● Memory module (see Expansion memory module on page 50)

● Primary hard drive (see Primary hard drive on page 55)

● Fan (see Fan on page 92)

● Heat sink (see Heat sink on page 94)

● WLAN module (see WLAN module on page 52)

● WWAN module (see WWAN module on page 58)
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Remove the system board:

1. Release the ZIF connector to which the front LED board cable is attached and disconnect the
front LED board cable (1) from the system board.

2. Disconnect the speaker cable (2) from the system board.

3. Remove the three Torx8 T8M2.5×6.0 screws (3) that secure the system board to the base
enclosure.

4. Flex the left side of the base enclosure (1) until the RJ-11 jack and USB ports are clear of the
openings in the base enclosure.

5. Use the optical drive connector (2) to lift the left side of the system board (3) until it rests at an
angle.

6. Remove the system board (4) from the base enclosure by sliding it up and to the left.

Reverse this procedure to install the system board.
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ExpressCard assembly

Description Spare part number

ExpressCard assembly 492567-001

Before removing the PC Card assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. WLAN module (see WLAN module on page 52)

c. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

d. Switch cover and keyboard (see Switch cover and keyboard on page 62)

e. Display assembly (see Display assembly on page 73)

f. Top cover (see Top cover on page 79)

g. System board (see System board on page 86)

Remove the ExpressCard assembly:

1. Turn the system board upside down, with the front toward you.

2. Remove the two Torx T8M2.0×5.0 screws that secure the ExpressCard assembly to the system
board.
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3. Turn the system board rightside up, with the rear toward you.

4. Remove the ExpressCard assembly.

Reverse this procedure to install the ExpressCard assembly.
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Modem module

Description Spare part number

Modem modules

NOTE: The modem module spare part kits do not include a modem module cable. The modem module cable is included in
the Cable Kit, spare part number 492555-001.

For use in all countries and regions except Australia and New Zealand 461750-001

For use only in Australia and New Zealand 461750-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. WLAN module (see WLAN module on page 52)

c. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

d. Switch cover and keyboard (see Switch cover and keyboard on page 62)

e. Display assembly (see Display assembly on page 73)

f. Top cover (see Top cover on page 79)

g. System board (see System board on page 86)

Remove the modem module:

1. Remove the two Phillips PM2.0×4.0 screws (1) that secure the modem module to the system
board.

2. Lift the modem module up (2) from the system board.

3. Disconnect the modem module cable (3) from the modem module.
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4. Remove the modem module .

Reverse this procedure to install the modem module.
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Fan

Description Spare part number

Fan (includes thermal material) 492568-001

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the right
side and rear panel of the computer. The computer uses an electric fan for ventilation. The fan is
controlled by a temperature sensor and is designed to turn on automatically when high temperature
conditions exist. These conditions are affected by high external temperatures, system power
consumption, power management/battery conservation configurations, battery fast charging, and
software requirements. Exhaust air is displaced through the ventilation grill located on the left side of
the computer.

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

c. Switch cover and keyboard (see Switch cover and keyboard on page 62)

d. Display assembly (see Display assembly on page 73)

e. Top cover (see Top cover on page 79)

f. System board (see System board on page 86)

Remove the fan:

1. Turn the system board upside down with the front toward you.

2. Remove the Phillips PM2.5×4.0 screw (1) securing the fan to the system board.

3. Disconnect the cable from the system board (2).
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4. Lift the fan up (3) to remove.

Reverse this procedure to install the fan.
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Heat sink

Description Spare part number

Heat sink (includes replacement thermal material and replacement thermal material cleaning kit) 492582–001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 46).

5. Remove the following components:

a. Primary hard drive (see Primary hard drive on page 55)

b. WLAN module (see WLAN module on page 52)

c. Optical drive (see Optical drive on page 60) or Secondary hard drive (see Secondary hard
drive on page 67)

d. Switch cover and keyboard (see Switch cover and keyboard on page 62)

e. Display assembly (see Display assembly on page 73)

f. Top cover (see Top cover on page 79)

g. System board (see System board on page 86)

Remove the heat sink:

1. Turn the system board upside down, with the front toward you.

2. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four Torx8
T8M2.0×10.0 screws (1) that secure the heat sink to the system board.
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3. Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
and system board each time the heat sink is removed. Thermal paste and pads are located on
the heat sink (1) and on system board components (2). Replacement thermal material is
included with all heat sink and system board spare part kits. Replacement thermal material is
included with all heat sink and system board spare part kits.

Reverse this procedure to install the heat sink.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ● Create a new BIOS user account.

● View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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Diagnostics menu

Select To do this

System Diagnostics menu ● F1 System Information—Displays the following
information:

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● F2 Start-up Test—Verifies the system components
needed for starting the computer.

● F3 Run-In Test—Runs a comprehensive check on
system memory.

● F4 Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

● F5 Error Log—Displays a log file if any errors have
occurred.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a Startup Menu delay (in seconds).

● Enable/disable Custom Logo (disabled by default).

● Enable/disable Display Diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD Card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE Internal NIC boot (enabled by
default).

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not
running.

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

● Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

● Enable/disable fan always on while connected to an AC
outlet (enabled by default).

● Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN
when not in use (enabled by default).

● Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (select models only)
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Select To do this

NOTE: Availability of the options above varies by
computer model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook 2 (enabled by default).

● Enable/disable Virtualization Technology (select models
only; disabled by default).

● Enable/disable TXT (Intel® Trusted Execution
Technology) (select models only; disabled by default).

● Enable/disable Dual Core CPU (select models only;
enabled by default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio (select
models only; enabled by default).

● Enable/disable embedded Bluetooth device radio
(enabled by default).

● Enable/disable the Network Interface Controller (LAN)
(enabled by default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network (set by default)

◦ Follow Boot Order

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the embedded WLAN device (enabled
by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Enable the ambient light sensor (enabled by default).

● Enable/disable the Notebook Multibay device (enabled
by default).

● Enable/disable the integrated camera (select models
only; enabled by default).
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Select To do this

Port Options (all are enabled by default) NOTE: All port options are enabled by default.

● Enable/disable the Smart Card slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

AMT Options NOTE: All AMT options are disabled by default.

● Enable/disable Firmware Verbosity.

● Enable/disable AMT Setup Prompt (CTRL-P).

● Enable/disable USB Key Provisioning Support.

● Enable/disable Unconfigure AMT on Next Boot.

● Enable/disable Terminal Emulation Mode.

● Enable/disable Firmware Progress Event Support.

● Enable/disable include TYPE-131 in SMBIOS.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Depth 21.43 cm 8.44 in

Width 28.23 cm 11.11 in

Height (front to rear) 2.52 to 3.40 cm 0.99 to 1.34 in

Weight

Equipped with DVD-ROM Drive, 9-cell battery, and WLAN
module

1.79 kg 3.95 lbs

Equipped with DVD-ROM Drive, 6-cell battery, and WLAN
module

1.64 kg 3.62 lbs

Equipped with DVD-ROM Drive, 3-cell battery, and WLAN
module

1.48 kg 3.26 lbs

Equipped with 3-cell battery and WLAN module 1.29 kg 2.84 lbs

Input power

Operating voltage 18.5 V dc @ 3.50 A – 65 W

Operating current 3.50 A

Temperature

Operating (reading to optical disc) 0°C to 35°C 32°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.
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12.1-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 16.9 cm 6.7 in

Width 26.2 cm 10.3 in

Diagonal 30.8 cm 12.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40 horizontal, +20/–40° vertical (typical)
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Hard drive specifications
 250-GB* 200-GB* 160-GB* 120-GB* 80-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm 70 mm

Weight 102 g 102 g 102 g 102 g 102 g

Interface type SATA SATA SATA SATA SATA

Transfer rate

Synchronous (maximum) 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 2 ms 3 ms 3 ms 3 ms

Average 13 ms 12 ms 13 ms 13 ms 13 ms

Maximum 24 ms 22 ms 24 ms 24 ms 24 ms

Logical blocks 495,702,655 390,721,968 317,249,699 237,937,274 158,624,849

Disk rotational speed 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

NOTE: Certain restrictions and exclusions apply. Consult technical support for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Accessible capacity is less. Actual drive specifications
may differ slightly.
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DVD-ROM Drive specifications
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18), CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-RW, Photo CD (single and multisession), and CD-Bridge

Access time CD DVD

Random < 100 ms < 125 ms

Cache buffer 512 KB

Data transfer rate

CD-R (24X) 3,600 KB/sec (150 KB/s at 1X CD rate)

CD-RW (10X) 1,500 KB/sec (150 KB/s at 1X CD rate)

CD-ROM (24X) 3,600 KB/sec (150 KB/s at 1X CD rate)

DVD 10,800 KB/sec (1,352 KB/s at 1X DVD rate)

Transfer mode 16.6 MB/sec Multiword DMA mode 2
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DVD±RW and CD-RW SuperMulti Double-Layer Combo
Drive specifications

Applicable disc Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-
R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

Write:

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2 MB

Data transfer rate   

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the
serial port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 Joystick (decoded in ESS1688)
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I/O address (hex) System function (shipping configuration)

202 - 21F Unused

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 ExpressCard controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
492579-001.
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Phillips PM 2.0×4.0 screw

Color Quantity Length Thread Head diameter

Black 16 4.0 mm 2.0 mm 4.5 mm

Where used: 1 screw that secures the Bluetooth module to the Bluetooth module compartment cover

Where used: 2 screws that secure the WLAN module to the base enclosure
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Where used: 2 screws that secure the WWAN board to the base enclosure

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 4 screws that secure the display hinges to the display panel

Phillips PM 2.0×4.0 screw 117



Where used: One screw that secures the top cover to the base enclosure

Where used: One screw that secures the speaker to the base enclosure

Where used: 2 screws that secure the modem module to the system board
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Where used: One screw that secures the fan to the system board
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Torx T8M2.0×5.0 screw

Color Quantity Length Thread Head diameter

Black 13 5.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive to the computer

Where used: 2 screws that secure the display assembly to the computer
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Where used: 4 screws that connect the bezel to the display assembly

Where used: One screw that secures the top cover to the base enclosure

Where used: One screw that secures the top cover to the base enclosure
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Where used: One screw that secures the primary hard drive to the computer

Where used: Two screws that secure the ExpressCard assembly to the system board
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Torx T8M2.0×6.0 captive screw

Color Quantity Length Thread Head diameter

Black 2 6.0 mm 2.0 mm 5.0 mm

Where used: 2 captive screws that secure the hard drive bracket to the primary hard drive (screws
secured by C-clips)
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 3 6.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the display panel to the display enclosure

Where used: One screw that secures the primary memory module shield to the top cover
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Phillips PM2.5×6.0 captive screw

Color Quantity Length Thread Head diameter

Black 5 6.0 mm 2.5 mm 5.0 mm

Where used:

(1) One captive screw that secures the Bluetooth module cover to the computer (screw is secured by
a C-clip)

(2) One captive screw that secures the memory module compartment cover to the computer (screw is
secured by a C-clip)

(3) One captive screw that secures the broadband wireless module compartment cover to the
computer (screw is secured by a C-clip)

(4) Two captive screws that secure the hard drive bay cover to the computer (screws are secured
by C-clips)
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Phillips PM2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 11 6.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the switch cover to the base enclosure

Where used: 4 screws that secure the optical bay hard drive to the computer
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Where used: 4 screws that secure the optical bay hard drive to the hard drive bracket

Where used: 2 screws that secure the hard drive to the connector board
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Torx T8M2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 11 6.0 mm 2.5 mm 5.0 mm

Where used: 6 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the top cover to the base enclosure
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Where used: 3 screws that secure the system board to the base enclosure
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Torx T8M2.5×9.0 captive screw

Color Quantity Length Thread Head diameter

Black 4 9.0 mm 2.5 mm 5.0 mm

Where used: 4 captive screws that secure the heat sink to the system board (screws secured by C-
clips)
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Phillips PM2.5×11.0 captive screw

Color Quantity Length Thread Head diameter

Black 5 11.0 mm 2.5 mm 5.0 mm

Where used: 5 captive screws that secure the keyboard to the computer (screws secured by C-clips)

Phillips PM2.5×11.0 captive screw 131



8 Backup and recovery

Backup and recovery in Windows Vista
Overview

To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files
and folders or create recovery points. In case of system failure, you can use the backup files to
restore your computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.
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Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the
discs to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9 Connector pin assignments

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Audio-in (microphone) 139



Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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IEEE 1394 (FireWire)

Pin Signal

1 Twisted-pair B, differential signals

2 Twisted-pair B, differential signals

3 Twisted-pair A, differential signals

4 Twisted-pair A, differential signals
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-11 (modem) 143



RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground

Universal Serial Bus 145



10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.
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Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port, identifying 14

A
AC adapter, spare part

number 32, 33
ambient light sensor,

identifying 11
AMT options

AMT setup prompt
(CTRL-P) 104

firmware progress event
support 104

firmware verbosity 104
terminal emulation mode 104
TYPE-131 in SMBIOS 104
unconfigure AMT on next

boot 104
USB key provisioning

support 104
antenna, disconnecting 54
applications key, Windows 10
audio, product description 2
audio-in (microphone) jack,

identifying 14
audio-in jack

pin assignments 139
audio-out (headphone) jack,

identifying 14
audio-out jack

pin assignments 140

B
backing up 133, 137
Backup and Restore

Center 132, 133
base enclosure, spare part

numbers 24, 34

battery
removal 46
spare part numbers 24, 46

battery bay 16
battery light, identifying 7, 12
battery release latches,

identifying 16
bays

battery 16
hard drive 16

BIOS administrator
password 100

Bluetooth module
removal 48
spare part number 48

Bluetooth module cable
removal 85

Bluetooth module compartment
cover

illustrated 31
Bluetooth module compartment,

identifying 16
boot options 102
boot order 102
broadband wireless module

compartment, identifying 16
built-in device

ambient light sensor 103
Bluetooth device radio 103
embedded WLAN 103
fingerprint reader 103
integrated camera 103
LAN/WLAN switching 103
modem 103
Network Interface Controller

(LAN) 103
Notebook Multibay 103
Wake on LAN 103

wireless button 103
WWAN device radio 103

built-in device options 103
business card slot, identifying 12
buttons

display release 12
info 8
keyboard light 11
pointing stick 5
power 8
presentation 9
TouchPad 5
TouchPad on/off 5
volume mute 9
wireless 8

C
cables, service considerations 38
caps lock light, identifying 6
chipset, product description 1
CMOS clearing 42
compartments

expansion memory module 17
WLAN module 17

components
bottom 16
front 12
left-side 15
rear 13
right-side 14
top 5
wireless antennae 18

computer feet
locations 45
spare part number 45

Computer Setup
accessing 96
Diagnostics menu 101
File menu 99
navigating and selecting 97
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restoring factory settings 98
Security menu 100
System Configuration

menu 102
using 97

computer specifications 105
connector, power 15
connectors, service

considerations 38

D
device configurations 102
Diagnostics menu 101
discs

Driver Recovery 138
Operating System 138

Disk Sanitizer 100
diskette drive

precautions 38
product description 2

display assembly
removal 73
spare part numbers 21, 73

display bezel
removal 76
spare part

numbers 27, 35, 73, 76
display bezel adhesive

spare part numbers 27, 35, 73
display component recycling 149
display enclosure, spare part

numbers 27, 35, 73
display hinge

removal 77
spare part

numbers 27, 33, 73, 77
display panel

spare part numbers 35
display panel cable

removal 77
spare part numbers 27, 35, 73

display panel, removal 76
display release button,

identifying 12
display specifications 106
drive light, identifying 7, 12
DriveLock password 100
DriveLock, automatic 100
Driver Recovery disc 138

drives
preventing damage 38

drives, boot order 102
Dual Core CPU 103
DVD-ROM Drive

spare part number 24
specifications 108

DVD-ROM drive
precautions 38

DVD/CD-RW Combo Drive
specifications 109

DVD±RW and CD-RW Combo
Drive

specifications 109
DVD±RW and CD-RW SuperMulti

Double-Layer Combo Drive
spare part number 23

E
electrostatic discharge 39
error log 101
esc key, identifying 10
Ethernet, product description 2
Execution Disable 102
expansion memory module

compartment, identifying 17
expansion port 3, identifying 14
ExpressCard assembly

spare part
numbers 23, 34, 88

ExpressCard slot, identifying 14
external media cards, product

description 3
external monitor port

pin assignments 141
external monitor port,

identifying 14

F
f11 recovery 135
fan

removal 92
spare part numbers 92

feet
locations 45
spare part number 45

File menu 99
fingerprint reader, identifying 9
fn key, identifying 10
function keys, identifying 10

G
graphics, product description 1
grounding equipment and

methods 41

H
hard disk test 101
hard drive

precautions 38
hard drive bay, identifying 16
hard drive recovery 135
headphone (audio-out) jack 14
headphone jack

pin assignments 140
heat sink

removal 94
spare part

numbers 23, 35, 94
hinge

removal 77
spare part numbers 77

HP QuickLook 2 103
HP SpareKey enrollment 100

I
I/O address specifications 112
IEEE 1394 (FireWire) port

pin assignments 142
IEEE 1394 port, identifying 14
info button, identifying 8
internal display switch,

identifying 8
internal hard drive

precautions 38
internal microphone,

identifying 11
interrupt specifications 111

J
jacks

audio-in (microphone) 14
audio-out (headphone) 14
RJ-11 (modem) 15
RJ-45 (network 13

K
keyboard

product description 3
removal 62
spare part numbers 22, 62
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keyboard light button,
identifying 11

keyboard light, identifying 11
keypad keys, identifying 10
keys

esc 10
fn 10
function 10
keypad 10
Windows applications 10
Windows logo 10

L
LAN Power Save 102
language, changing in Computer

Setup 102
latches, battery release 16
LED board

removal 82
spare part

numbers 23, 35, 82
left TouchPad button 5
legacy support, USB 96, 102
lights

battery 7, 12
caps lock 6
drive 7, 12
keyboard 11
mute 6
num lock 6
power 6, 12
TouchPad on/off 6
volume mute 6
webcam 11
wireless 6, 12

M
memory map specifications 114
memory module

product description 1
removal 50
spare part number 50
spare part numbers 23, 35, 72

memory module compartment
cover

illustrated 31
removal 50, 54

memory module compartment,
identifying 17

microphone (audio-in) jack 14

microphone jack
pin assignments 139

model name 1
modem jack

pin assignments 143
modem module

product description 2
removal 90
spare part numbers 23, 90

monitor port
pin assignments 141

monitor port, external 14
mute button, identifying 9
mute light, identifying 6

N
network jack

pin assignments 144
num lock light, identifying 6

O
Operating System disc 138
operating system, product

description 4
optical drive

identifying 15
precautions 38
product description 2
removal 60
spare part numbers 23, 30, 60
specifications 108, 109

P
packing guidelines 40
panels, product description 1
parallel port mode 102
password clearing 42
passwords 100
PC Card assembly

removal 88
PC Card slot bezel, illustrated 31
pin assignments

audio-in jack 139
audio-out jack 140
external monitor port 141
headphone jack 140
IEEE 1394 (FireWire)

port 142
microphone jack 139
modem jack 143
monitor port 141

network jack 144
RJ-11 143
RJ-45 jack 144
Universal Serial Bus (USB)

port 145
plastic parts 37
Plastics Kit

contents 31
spare part number 31
spare part numbers 23, 35

pointing device
product description 3

pointing stick buttons,
identifying 5

pointing stick, identifying 5
port options

1394 port 104
ExpressCard slot 104
flash media reader 104
parallel port 104
serial port 104
Smart Card slot 104
USB port 104

ports
1394 14
external monitor 14
powered USB 15
product description 3
USB 14, 15

power button, identifying 8
power connector, identifying 15
power cord

set requirements 146
spare part number 32, 34

power light, identifying 6, 12
power requirements, product

description 4
powered USB port,

identifying 15
presentation button, identifying 9
primary hard drive

description 2
removal 55
spare part numbers 29, 55
specifications 107

primary hard drive bay cover
removal 55

processor, product description 1
product description

audio 2
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chipset 1
diskette drive 2
docking 3
Ethernet 2
external media cards 3
graphics 1
hard drives 2
keyboard 3
memory module 1
modem module 2
operating system 4
optical drives 2
panels 1
pointing devices 3
ports 3
power requirements 4
processors 1
product name 1
security 4
serviceability 4
wireless 3

product name 1

R
RAID (Redundant Array of

Independent Disks)
devices 102

rear cover
illustrated 31

recovery partition 135
release latches, battery 16
removal/replacement

preliminaries 37
procedures 43

restore security defaults 104
restore the factory settings 99
restoring the hard drive 135
RJ-11 (modem) jack,

identifying 15
RJ-11 jack

pin assignments 143
RJ-45 (network) jack,

identifying 13
RJ-45 jack

pin assignments 144
RTC battery

removal 66
spare part

numbers 22, 33, 66
run-in test 101

S
SATA (Serial Advanced

Technology Attachment) devices
AHCI (Advanced Host

Controller Interface) 102
IDE (Integrated Drive

Electronics) 102
Screw Kit

contents 115
spare part number 32, 35

screw listing 115
scroll zone, TouchPad 5
SD Card Reader, identifying 14
Secondary Battery Fast

Charge 103
secondary hard drive

description 2
removal 67
spare part numbers 24, 29, 67
specifications 107

security cable slot, identifying 13
Security menu

allow reset of HP ProtectTools
security keys 100

always prompt for HP
SpareKey enrollment 100

Automatic DriveLock 100
change password 100
Disk Sanitizer 100
DriveLock 100
fingerprint reader reset 100
HP Sparekey 100
HP Sparekey enrollment 100
password policy 100
set up BIOS administrator

password 100
System IDs 100
user management 100

security, product description 4
serial number 19, 44
service considerations 37
serviceability, product

description 4
set security level 104
setup utility

Diagnostics menu 101
File menu 99
navigating and selecting 97
restoring factory settings 98

Security menu 100
System Configuration

menu 102
SIM

removal 47
spare part number 47

SIM slot, identifying 16
slots

broadband wireless
module 16

business card 12
ExpressCard 14
memory module 17
SD Card Reader 14
security cable 13
SIM 16
WLAN module 17

solid-state hard drive
description 2
removal 55
spare part numbers 24, 29, 55

speaker
removal 84
spare part

numbers 23, 33, 84
speaker, identifying 17
specifications

computer 105
display 106
DVD-ROM Drive 108
DVD/CD-RW Combo

Drive 109
DVD±RW and CD-RW Combo

Drive 109
hard drive 107
I/O addresses 112
interrupts 111
memory map 114
optical drive 108, 109
system DMA 110

start-up test 101
static-shielding materials 41
switch cover

removal 62
spare part

numbers 22, 34, 62
system board

removal 86
spare part numbers 23, 86

System Configuration menu 102
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system date and time 99
System Diagnostics menu 101
system DMA 110
system fan 102
system IDs 100
system information 99
system memory map 114

T
thermal material, replacement 95
tools required 37
top cover

removal 79
spare part

numbers 23, 34, 36, 79
TouchPad on/off button,

identifying 5
TouchPad on/off light,

identifying 6
TouchPad scroll zone 5
TouchPad, identifying 5
TPM Embedded Security 100
transporting guidelines 40
TXT (Intel® Trusted Execution

Technology) 103

U
Unified Extensible Firmware

Interface (UEFI) mode 103
Universal Serial Bus (USB) port

pin assignments 145
unknown password 42
USB legacy support 96, 102
USB ports, identifying 14, 15

V
vents, identifying 14, 15, 16
Virtualization Technology 103
volume mute button, identifying 9
volume mute light, identifying 6
volume scroll zone, identifying 9

W
webcam light, identifying 11
webcam, identifying 11
Windows applications key,

identifying 10
Windows Backup

utility 136, 137, 138
Windows logo key, identifying 10
Windows recovery 138

Windows Vista operating system
DVD 135

wireless antenna,
disconnecting 54

wireless button, identifying 8
wireless light, identifying 6, 12
wireless, product description 3
WLAN antennae, identifying 18
WLAN module

removal 52
spare part numbers 24, 52

WLAN module compartment,
identifying 17

workstation guidelines 40
WWAN antenna, identifying 18
WWAN module

removal 58
spare part numbers 58
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